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Introduction

The only thing standing between you and your writing is your word proces-
sor. Yes, it tries to be helpful, but computers can do only so much. As a 
smart person, you desire more help than the computer is capable of giving, 

which I’m guessing is why you opened this book.

Welcome to Word For Dummies, which removes the pain from using Microsoft’s 
greatest and most bewildering word processing software ever! This book is your 
friendly, informative, and entertaining guide to getting the most from Word.

Be warned: I’m not trying to force you to love Word. This book won’t make you 
enjoy the program. Use it, yes. Tolerate it, of course. The only promise I’m offer-
ing is to ease the pain that most people feel from using Microsoft Word. If you get 
in a good laugh at Word’s expense along the way, all the better.

About This Book
Please don’t read this book from cover to cover. It’s not a novel, and if it were, it 
would be a political space opera with an unlikely antihero and a plucky princess 
fighting corrupt elected officials who are in cahoots with an evil intergalactic 
urban renewal development corporation. The ending would be extremely 
satisfying.

This book is a reference. Each chapter covers a specific topic or task that Word 
otherwise pretends is easy. Within each chapter, you find self-contained sections, 
each of which describes how to perform a specific task or get something done. 
Here are some sample topics you encounter in this book:

»» Moving a block

»» Check your spelling

»» Save your stuff!

»» Text formatting techniques

»» Working with tables in Word
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»» Plopping down a picture

»» Mail merge, ho!

»» Drafting with Copilot

I give you no codes to memorize, no secret incantations, and no tricks. Nothing is 
assumed, and everything is cross-referenced. Technical terms and topics, when 
they come up, are neatly shoved aside, where you can easily avoid reading them. 
The idea here isn’t for you to master anything. This book’s philosophy is to help 
you look it up, figure it out, and get back to writing that novel, grocery list, or 
secret plan to invade Liechtenstein.

How to Use This Book
You hold in your hands an active book. The topics between this book’s yellow- 
and-black covers are all geared toward getting things done in Word. All you need 
to do is find the topic that interests you and then read.

Word uses the mouse and keyboard to get things done, but mostly the keyboard.

I use the word click to describe the action of clicking the mouse’s main (left) button.

This is a keyboard shortcut: Ctrl+P. Press and hold down the Ctrl (Control) key and 
type the letter P, just as you would press Shift+P to create a capital P.

Sometimes, you must press more than two keys at the same time, such as 
Ctrl+Shift+T. Press Ctrl and Shift together and then press the T key. Release all 
three keys.

Commands in Word exist as command buttons on the ribbon interface. I refer to the 
tab, the command group, and then the button itself to help you locate a specific 
command button.

Menu commands are listed like this: Table ➪   Insert Table. This direction tells you 
to click the Table command button and then choose the Insert Table item from the 
menu that appears.

Some of Word’s key commands dwell on the File screen. To access this screen, 
click the File tab on the ribbon. To return to the document, click the Back button, 
found in the upper left corner of the File screen and shown in the margin. Or you 
can press the Esc key.
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When I describe a message or some text you see onscreen, it looks like this:

Why should I bother to love you, Evelyn, when my
female robot makes better tacos?

If you need further help with operating your computer, I can recommend my book 
PCs For Dummies (Wiley). It contains lots of useful information to supplement what 
you find in this book.

Foolish Assumptions
This book was written with a few assumptions. Foremost, I assume that you’re a 
human being, though you might also be a pod person, but, heck, they need to 
write, too.

Another foolish assumption I make is that you use Windows as the computer’s 
operating system. Both Windows 10 and Windows 11 are current, though which 
version you’re using makes no difference to this book. This book doesn’t 
cover Windows.

This book focuses on the Microsoft 365 subscription version of Microsoft Word. It 
also applies to the standalone version, as well as Microsoft Word online. Most 
recent versions of Word forward are similar, so you should be covered here. This 
book also mentions the Copilot artificial intelligence feature, which is an extra 
subscription service beyond Microsoft 365.

This book does not cover the macOS version of Word that runs on a Macintosh 
computer. This version of Word is different from what’s covered in this book. Very 
little of the text here applies to the macOS version of Word. Sorry.

Icons Used in This Book
This icon flags useful, helpful tips or shortcuts.

This icon marks a friendly reminder to do something.
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This icon marks a friendly reminder not to do something.

This icon alerts you to overly nerdy information and technical discussions of the 
topic at hand. The information is optional reading, but it may enhance your repu-
tation at cocktail parties if you repeat it.

Where to Go from Here
Start reading! Behold the table of contents and find something that interests you. 
Or look up your puzzle in the index.

Read! Write! Let your brilliance shine!

My email address is dgookin@wambooli.com. Yes, this is my real address. I reply 
to all email I receive, and you get a quick reply if you keep your question short and 
specific to this book or to Word itself. Although I enjoy saying hi, I cannot answer 
technical support questions or help you troubleshoot your computer. Thanks for 
understanding.

You can also visit my web page for more information or as a diversion: www.
wambooli.com.

My YouTube channel contains hundreds of videos about Word, including tips, 
tricks, and tutorials. Check it out at youtube.com/dangookin.

To find this book’s online Cheat Sheet, simply go to www.dummies.com and search 
for Word For Dummies Cheat Sheet in the Search box.

Enjoy this book. And enjoy Word. Or at least tolerate it.

mailto:dgookin@wambooli.com
http://www.wambooli.com
http://www.wambooli.com
https://youtube.com/dangookin
http://www.dummies.com
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IN THIS PART . . .

See how to start Word and decipher the Word screen.

Explore differences between Word the program and 
Word online.

Get to know the computer keyboard and the 
touchscreen.

Learn how to read the status bar and discover special 
symbols representing secret characters in your text.



CHAPTER 1  Word Origins      7

Chapter 1
Word Origins

Before you get too far into word processing, keep in mind that the pencil is 
truly the ultimate writing tool. Its application is obvious. It’s easy to use, 
it’s wireless, and it features an eraser — the original Undo command. This 

information is presented in the seminal book Pencils For Dummies, which weighs in 
at a hefty six-and-a-half pages.

This book is far longer than Pencils For Dummies. The reason is that Microsoft Word 
is a far more powerful and sophisticated tool than your typical Ticonderoga #2. 
Though, as a bit of trivia, when Microsoft Word made its debut in 1983, one of the 
more popular word processing programs at the time was called Electric Pencil.

Word of the Day
Today’s word is Start. Yesterday’s word was Run. Tomorrow’s word is Launch.

These terms all describe how to begin your word processing day with Microsoft 
Word. Even so, the method by which you coax Word into existence depends upon 
what you want to do with the program.

IN THIS CHAPTER

»» Starting Word

»» Deciphering the Word screen

»» Understanding the ribbon

»» Viewing a document

»» Zooming in and out

»» Quitting Word

»» Minimizing Word
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»» Obviously, you can’t use Word unless your computer is on and toasty.

»» Please don’t put toast into your computer.

»» Word can be obtained as its own program, which is part of the Microsoft 
Office suite of programs, or as a subscription to the Microsoft 365 service.

»» The computer version of Word dwells on your PC’s mass storage device, 
where it labors as a program, like so many others.

»» The online version of Word abides ethereally on the Internet. Yes, the Internet 
must be available for you to access this version, though you can do so from a 
mobile device as well as from a computer.

»» Ensure that you sport a proper posture as you write. Your wrists should be 
even with your elbows. Your head should tilt down only slightly, though it’s 
best to look straight ahead. Keep your shoulders back and relaxed. Uncross 
your toes.

Starting Word, the program
As a program on your computer, Word is nothing special. It’s started like any 
other program, even those not used by great writers such as Tolstoy, Stein, and 
Faulkner. Follow these same steps as those authors writing their immortal texts:

1.	 Tap the Windows key on the keyboard.

The Windows key sits squat between the left Ctrl and Alt keys on the keyboard. 
The key may be adorned with the Windows logo icon or the keyboard manu-
facturer’s icon.

Upon success, the Start menu pops up.

2.	 Type word.

As you type, programs matching word appear on the Start menu. The program you 
desire is titled Word, with the subtitle App. Yes, App is the program’s last name.

3.	 Choose the Word app to start the program.

Watch in amazement as the program unfurls upon the screen.

Starting Word, the online version
The web-based version of Word works best when you’re already familiar with the 
program version. This pale version of the program is available at this address:

office.com/launch/word

https://www.office.com/launch/word
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If you aren’t already signed into your Microsoft account, you’ll be pestered to do 
so. After identifying yourself to the digital warden, you see the online version of 
the Word Start screen. See the later section “Working the Word Start screen.”

»» The online version of Word is limited from the full power of the Word 
program. Differences are ridiculed throughout this book.

»» You need a Microsoft 365 account to use the online version of Word.

»» Word online grants you access to the documents saved to your OneDrive 
folder. OneDrive is Microsoft’s cloud application, providing access to your files 
over the Internet. Microsoft badly wants you to use OneDrive and will pester 
you about it endlessly.

Opening a document to start Word
Word spawns documents like hens spawn eggs. Open an egg and you see break-
fast. Open a Word document and you see the Word program with the document 
presented inside, ready for action — no cooking required.

POKING A PIN IN THE WORD PROGRAM
I use Word every dang doodle day. To make its initiation easy when inspiration strikes, 
I pin the Word program’s icon to the taskbar (in Windows 10) or the Start menu (in 
Windows 11). This pin draws no blood, but instead permanently affixes the program’s 
icon in a handy location from whence it can be started quickly.

To pin Word, follow Steps 1 and 2 in the earlier section “Starting Word, the program.” 
Below the Open item that appears, you find two other actions: Pin to Start and Pin to 
Taskbar. (If you don’t see these items in Windows 10, click the chevron to expand the list 
of actions.)

When you pin the Word icon to the Start menu, it’s readily accessible each time you pop 
up the Start menu.

Pinning the icon to the taskbar means the icon always appears on the taskbar, at the 
bottom of the screen.

Clicking the Word icon from its pinned location starts the program instantly, which gets 
you writing more quickly, before those lingering thoughts escape from your head.
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To open a document and start Word, obey these steps:

1.	 Locate the document icon.

Use your Windows kung fu to open the proper folders and hunt down a Word 
document icon, as shown in the margin.

Online, browse your OneDrive folder for Word document icons, though the 
icon image is often replaced with a thumbnail image showing the document’s 
teeny-tiny contents.

2.	 Double-click the icon.

On OneDrive, a single click is all you need.

The document is opened and presented on the screen, ready to sate your 
writing whims.

»» You use Word to create documents. These are saved to storage on your 
computer or on the cloud. Details are offered in Chapter 8.

»» Documents you create on the cloud stay there — unless you have the cloud 
app (such as OneDrive) installed on your computer. In this configuration, the 
cloud files are also available on your computer. Likewise, files you save to the 
cloud storage folder (or one of its subfolders) on your computer are also 
available on the cloud, and you can use the online version of Word to 
abuse them.

»» The document’s name is assigned when it’s first saved. Use this name to 
determine the document’s contents — providing that it was properly named 
when first saved.

»» Documents are files. They exist separately from the Word program, saved 
individually on the computer’s storage media. As such, they are managed by 
Windows. To organize, manage, and find lost documents, you use 
Windows, not Word.

Your First Word
As a program, Word presents itself on the screen in a window adorned with vari-
ous gadgets and goobers designed to assist or thwart you in the writing process. If 
you’ve been victimized by computers for some time, this presentation should be 
familiar to you, though some items may be new or odd. After all, if every program 
worked the same, people would be far happier using computers, and such a notion 
chills me.
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Working the Word Start screen
Word begins its existence by thrusting forward a Start screen, illustrated in 
Figure 1-1.

The advantage of the Start screen is that it shows recently opened documents. If 
you want to pick up working where you left off, choose a document from the items 
listed (refer to Figure 1-1).

To start a new document — that foreboding fresh sheet of digital paper — click 
the Blank Document button.

Recently used templates also appear in the list, allowing you to start a new docu-
ment with styles, text, and stuff ready for you to work.

FIGURE 1-1: 
The Word 

Start screen.
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After making your choice, all excuses are gone. Time to start writing.

»» A template is a document that contains preset elements, such as formatting, 
styles, text, and possibly graphics. Use a template to help you start a common 
type of document, such as a résumé, a report, or an angry letter to the editor. 
See Chapter 16.

»» Pinned documents are those you want to keep in the list shown on the Start 
screen, such as a recipe you’re working on to make it more digestible. Choose 
the Pinned tab (refer to Figure 1-1) to see the list. Chapter 8 coughs up details 
on pinning a document.

»» The Word Start screen doesn’t appear when you open a document to start 
Word, as foretold in the earlier section “Opening a document to start Word.”

»» You can disable the Start screen so that Word always opens with a blank 
document. Chapter 33 discloses the secret. The Start screen cannot be 
disabled in Word’s web version.

»» The Word Start screen appears only when you first start the Word program. 
It doesn’t appear every dang time you start a new document while using 
the program.

Beholding Word’s main screen
Writing is scary enough when you first see that ominous blank page. With a com-
puter, the level of terror increases because Word festoons its program window 
with all kinds of controls, options, and doodads. I recommend that you refer to 
Figure 1-2 to recognize what these items are called. Ignore this jargon at your peril.

The details of how all these gizmos work, and the terms to describe them, are 
covered throughout this book. The good news is that the basic task of typing text 
is straightforward. See Chapter 2 to get started.

»» The view buttons (Read Mode, Print Layout, and Web Layout in the lower right 
corner in Figure 1-2) are absent from the online version of Word.

»» To get the most from Word’s window, adjust its size: Use the mouse to drag 
the window’s edges outward. You can also click the window’s Maximize button 
(refer to Figure 1-2) to have the window fill the screen.

»» The largest portion of Word’s screen is used for composing text. It looks like a 
fresh sheet of paper, but it doesn’t smell the same. If you choose to use a 
template to start a new document, this area may contain some preset text.
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Navigating the ribbon
An important part of Word’s interface is the ribbon. This festive name refers to a 
location where the majority of Word’s commands dwell and where settings are 
made. These items appear as buttons, input boxes, and menus. Alas, you find no 
bows on the ribbon.

The ribbon is divided into tabs, as illustrated in Figure 1-3. Each tab holds separate 
groups. Within the groups, you find the command buttons and doodads that carry 
out various word processing duties.

To use the ribbon, first click a tab and then choose a command from a group. For 
example, to set the right paragraph alignment, click the Home tab and then look 
in the Paragraph group for the Align Right button. Click the button to activate 
the command.

Some buttons feature a menu, which pops up automatically or when you click the 
down-pointing chevron next to the button.

FIGURE 1-2: 
Word’s visage.
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Various tabs on the ribbon may feature a gallery, which is a palette of buttons that 
preview information, such as the paragraph styles shown in Figure 1-3. Click the 
Show Gallery button to display the entire gallery of thumbnails.

»» This book describes finding commands on the ribbon in this manner: tab, 
group, command button.

»» The online version of Word features a different ribbon, more abbreviated than 
the full Word program.

»» Some items on the ribbon let you input text or values.

»» Use the Dialog Box Launcher icon in the lower right corner of a group to open 
a dialog box that’s relevant to the group’s function. Not every group features a 
dialog box launcher.

»» The amazingly frustrating thing about the ribbon is that it can change. Some 
tabs appear and disappear, depending on what you’re doing in Word. Groups 
and icons (buttons) come and go, depending on the width of Word’s pro-
gram window.

»» To ensure that you always see all command buttons on the ribbon, adjust the 
program’s window as wide as is practical.

»» Clicking the File tab replaces the contents of the Word window with a screen 
full of commands and other information. To return to the Word window, click 
the Back button (shown in the margin) or press the keyboard’s Esc key.

Showing and hiding the ribbon
Yes, some users desire the ribbon to go away and be replaced by the familiar old 
menu system. Alas, this change will never happen. But, to ensure that you hold a 
continued level of frustration, Microsoft believes that showing and hiding the rib-
bon is a feature. Don’t be surprised when the ribbon disappears altogether, though 
you can control its fate.

FIGURE 1-3: 
The ribbon.


